MultiBrush

Photo Retouching Made Easy

akvis.com
- Move
- Transform
- Text
- Eyedropper
- Hand
- Zoom

- Examples
  - Changing Eye Color
  - Portrait Editing
  - Odd Man Out
  - Alter Ego

- AKVIS Programs
AKVIS MultiBrush is rich in features and easy-to-use image editing software. It is an all-in-one photo enhancement and portrait retouching solution.

MultiBrush is a real laboratory, in which you can edit a portrait, restore an old image, paint funny details on a photo or create an image from scratch. The program offers two sets of tools — Standard and Artistic Brushes.

Healing and Retouching Images

**Chameleon Brush** heals skin problems and removes dust, spots and scratches without affecting background texture, lighting or colors. This unique brush is similar to Adobe Healing Brush, yet offers more flexibility and customization options.

AKVIS MultiBrush is indispensable when you need to revive old black and white photos. Using a set of brushes, especially Chameleon Brush and Clone Stamp, you can restore many old, damaged scanned images. The program can remove dust, scratches, and spots from the surface of an image. Your family photo album will have a second life.

**Impressive Collages with Artistic Cloning**

The Artistic Cloning mode of the Chameleon Brush tool makes AKVIS MultiBrush truly unique. This innovative mode makes it possible to clone parts of a picture in a really smart way. Sample, adjust and re-source parts you’re about to multiply through the image, and create impressive collages with little effort.

The ordinary Stamp tool enriched with the innovative features of rotation and scaling of the cloned area, lets you achieve impressive results.

**An Artist's Studio - Painting Tools**

MultiBrush can not only be used to edit photos, but also to add various creative effects and even draw a painting. The program includes Artistic Brushes — a set of tools for creative people: Oil Brush, Artistic Spray, Artistic Pencil, Felt-tip Marker, Chalk and others.
With these wonderful tools, which mimic the work of actual brushes, you can decorate a photo, for example, by drawing an edge or adding some interesting detail, which will add zest to an image. You can even create a new image, painted in oil or chalk.

**Essential Features: Crop, Move, Text...**

MultiBrush is an easy to use photo editing program. It offers the most popular operations with images. The software lets you crop a photo to improve its composition, to remove unwanted parts, or to prepare it for printing. You can move objects and add texts.

**Layers, Channels, History**

It's possible to edit image channels and work with layers, which open up practically unlimited possibilities for editing digital photos. One of the most useful features of MultiBrush is full control of the history of all actions through checkpoints which can be used to quickly return to any state of an image.

**AKVIS Format**

The software supports many formats - TIFF, JPEG, BMP, PNG, PSD, and the special AKVIS format which lets you losslessly save a working draft of your project into a file. The AKVIS file contains the state of the image at the moment it was saved, all layers (raster, artistic, text) and groups, with their properties, and (for Deluxe/Business versions) manually created checkpoints added during your work (in History).

**Compatibility: Advanced Retouch and Enhancement Tools for Everyone!**

The software makes these outstanding tools available for Standalone customers and Plugin users which work with photo editing products such as Adobe Photoshop and Photoshop Elements, Corel Paint Shop Pro and PhotoImpact, Corel Photo-Paint, and many more supporting Photoshop PlugIns architecture on Windows and Mac platforms.
Attention! You must have administrator rights to install the program on your computer.
Before installing the AKVIS Plugin, please make sure that the photo editor where you want to install the plugin, is closed.

Follow the instructions to install **AKVIS MultiBrush** in Windows.

- Start the setup **exe** file.
- Select your language and press the **OK** button to launch the installation process.
- To continue the installation process you have to read and accept the **License Agreement**.
  Activate the check box "**I accept the terms in the license agreement**", and press **Next**.

- To install the **Plugin** you should select your photo editor(s) from the list.

  **Hint:**
  
  If your photo editor is not in the list, activate the component **Custom Plugins Directory** and choose the folder where you keep all plugins and filters, for example, **C:\My Plugins**. In this case you should set this folder as the plugins folder in the settings of your photo editor.

  Or you can copy the **8bf** file into the Plug-ins folder of your image editor.

To install the **Standalone version**, make sure that the check-box **Standalone** is activated.
To create a shortcut for the program on desktop, activate the component **Shortcut on Desktop**.

Press the button **Next**.
Press the button **Install**.

The installation is in progress.
The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates and events. Enter your e-mail address.

Press Finish to exit Setup.

After installation of the standalone version of MultiBrush, you will see a new line in the Start menu: AKVIS - MultiBrush and a shortcut on desktop, if during installation the component Shortcut on Desktop was enabled.
After installation of the MultiBrush plugin you will see a new item in the Filter/Effects menu of your photo editor. For example in Photoshop: Filter -> AKVIS -> MultiBrush. Please use this command to launch the plugin in the editor.
**INSTALLATION**

**Attention!** You must have administrator rights to install the program on your computer.

Before installing the AKVIS Plugin, please make sure that the photo editor where you want to install the plugin, is closed.

Follow the instructions to install **AKVIS MultiBrush** in Mac OS X:

- Open the virtual disk **dmg**:
  - **akvis-multibrush-app.dmg** to install the **Standalone** version
  - **akvis-multibrush-plugin.dmg** to install the **Plugin** to your image editor.
- Read the **License Agreement** and press **Agree**, if you agree with the conditions.

- **Finder** will open with **AKVIS MultiBrush** application or **AKVIS MultiBrush PlugIn** inside.
To install the **Standalone** version just drag the **AKVIS MultiBrush** application into the folder **Applications** (or any other place you like).

To install the **Plugin** drag the entire **AKVIS MultiBrush PlugIn** folder into the **Plug-Ins** folder of your graphic editor.

For example:

If you use **Photoshop CS6**, move the plugin into **Applications/Adobe Photoshop CS6/Plug-ins**.

To add the plugin to **Photoshop CC**, copy it into **Applications/Adobe Photoshop CC/Plug-ins**.

After installation of the MultiBrush plugin, you will see a new item in the Filter/Effects menu of your photo editor: **AKVIS - > MultiBrush**. Please use this command to launch the plugin in the editor. For example, in Photoshop select in menu: **Filter - AKVIS - MultiBrush**.

The standalone version is run by double-clicking on the application.
HOW TO REGISTER AKVIS SOFTWARE

To buy a license you should fill in the form on the product buy-page and order the software using a secure payment system. We offer a number of payment options (credit card, bank transfer, etc). When the form is filled in and the payment is made, the serial number will be sent to you within minutes.

Having received the serial number you can proceed to the program registration.

Attention! During the activation process your computer must be connected to Internet. If it is not possible, we offer you an alternative way (see below for Offline Activation).

Follow the steps below to register the program:

o Open the window About the program of AKVIS MultiBrush.

This window appears when you launch AKVIS MultiBrush. You can also see this window by pressing the button in the program. Also, Adobe Photoshop lets you call the About the program window right from its menu Help -> About Plug-In -> MultiBrush (Photoshop -> About Plug-In -> MultiBrush in Macintosh).

Note that the functionality of the program depends on the license type. During the test period you can try all options and choose the license you like. For this select in the window About the program one of the offered functionality types: Home, Deluxe or Business (below these is a brief description of the features of the license types). Your choice of license will affect which features are available in AKVIS MultiBrush.

The button Buy redirects you to the order page, where one can continue to choose a program or proceed to registration.

If you have a Home license you can improve it (for example, upgrade to Home Deluxe or Business) any time by paying the price difference. Click on the Upgrade button (it appears instead of Buy if the program is registered).

Please consult the comparison table for more details about license types and versions of the program.
Click on **Activate** in the window **About the program** to start the activation process.

Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by mail.

We recommend activating the program using direct connection, as it is the easiest way. At this step your computer must be connected to Internet.

If you choose activation via email please put the lic-file into the folder AKVIS in Users' Shared (Public) Documents, and the program will be registered.

Press the button **Activate**.

The registration is completed.

You can start working with the photo editing software and building your unique photo collection.

---

**Note:** In case you have chosen **activation by mail**, you should put the file **MultiBrush.lic** (that you will receive enclosed in the e-mail) into the folder **AKVIS** in **Users' Shared (Public) Documents**:

- **Windows Vista, Windows 7, Windows 8:**
Users\Public\Documents\AKVIS;

- **Windows XP:**
  - Documents and Settings\All Users\Documents\AKVIS;

- **Mac OS X:**
  - Users/Shared/AKVIS or a user’s home folder.

Do not try to open the license file (it won’t work), just copy it!

**If your computer is not connected to Internet**

If your computer can not be connected to Internet, follow the instructions below:

- Choose the option **Send a request via e-mail** as a method of activation. Your mailing program will create an activation letter with all necessary information.

- Save the message to a USB stick and transfer to the computer connected to Internet. Send us this information.

  **Please do not send the screenshot!** Just copy the text and save it.

  We need your serial number for the software, HardwareID of your computer, and your activation name.

- We will generate your license file (**MultiBrush.lic**) and will send it to you.

- Save the **.lic** file to a USB stick and move it to your computer where you want to register the software.

  Put the file in the folder **AKVIS** in **Users’ Shared (Public) Documents** (*see above*).
PHOTO RETOUCHING MADE EASY

Retouch photos and enhance portraits quickly and easily with **AKVIS MultiBrush**!

The functionality of the program depends on the license type. During the test period you can try all options and choose the license you like.

Every time you start the unregistered version you can choose between functionality types to test: Home (either the plugin or the standalone edition), Home Deluxe (plugin+standalone) or Business (plugin+standalone).

<table>
<thead>
<tr>
<th>License Comparison:</th>
<th>Home (Plugin)</th>
<th>Home (Standalone)</th>
<th>Home Deluxe (Plugin+Standalone)</th>
<th>Business (Plugin+Standalone)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Purpose</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>non-commercial use</em></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><em>commercial use</em></td>
<td>—</td>
<td></td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Edition</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Plugin</strong></td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Standalone</strong></td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Features</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Toolbar:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standard Brushes</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Artistic Brushes</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Common Tools</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Palettes:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Swatches</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Layers</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>History</td>
<td>—</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Channels</td>
<td>—</td>
<td></td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td><strong>Additional Features:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save/Load Projects (*.akvis)</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Print</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>EXIF, IPTC</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Color Space</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RGB</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>CMYK</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Lab</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Feature</td>
<td>Windows</td>
<td>Mac OS X</td>
<td>10-days trial</td>
<td>Price</td>
</tr>
<tr>
<td>------------------</td>
<td>---------</td>
<td>----------</td>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Grayscale</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>$49 - €39</td>
</tr>
<tr>
<td>8 / 16 bits</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>$49 - €39</td>
</tr>
<tr>
<td>32 bits</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>$65 - €50</td>
</tr>
<tr>
<td>Image Format</td>
<td></td>
<td></td>
<td></td>
<td>$89 - €69</td>
</tr>
<tr>
<td>AKVIS</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIFF</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JPEG</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BMP</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PNG</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RAW</td>
<td>✓</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PSD</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OS</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mac OS X</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10-days trial</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Price</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
AKVIS FORMAT

The software offers the special **AKVIS** format which lets you losslessly save a working draft of your project into a file.

Click on 📊 and select **AKVIS Document (*.akvis)** from the **Format** list. To load the file use 📚.

The **AKVIS** file contains the state of the image at the moment it was saved, all layers (raster, artistic, text) and groups, with their properties, and manually created checkpoints added during your work (in History).

The **AKVIS** format provides helpful opportunities to work with files:

1. saving a document structure (layers, their groups and properties);
2. saving artistic and text layers without rastering them;
3. saving checkpoints (the possibility to revert to a previous state) - for **Deluxe/Business** versions;
4. saving a selection;
5. saving guidelines;
6. saving the original image (creating a checkpoint or a background layer's copy).

We recommend you to use the **AKVIS** format to save a draft or a backup copy. You can save the final result using **JPG, TIFF, PNG** formats, to be able to share it.
AKVIS MultiBrush can work independently as a standalone program as well as a plug-in to a photo editor.

To call the AKVIS MultiBrush plug-in in Adobe Photoshop select the menu item Filter -> AKVIS -> MultiBrush; in Paint Shop Pro select the menu item Effects -> Plugins -> AKVIS -> MultiBrush; in Corel Photo-Paint select the menu item Effects -> AKVIS -> MultiBrush.

To launch the standalone version of AKVIS MultiBrush follow the instructions:

- On a Windows computer:
  - In the main menu: press the button Start and select from the pop-up menu the command AKVIS -> MultiBrush.
  - Using the program's shortcut on the Desktop: put the cursor on the icon of the program AKVIS MultiBrush and double-click it with the left mouse button.

- On a Macintosh computer:
  - Using Finder: select the folder Applications on the side bar of the Finder window, select the application AKVIS MultiBrush and double-click it.

Under Windows the AKVIS MultiBrush program window looks like this:

The central part of the AKVIS MultiBrush window is taken by the Image Window. Right-clicking in the Image Window calls the settings of the selected tool.

In the upper part of the program’s window you can see the Control Panel with following buttons:

- The button opens the home page of AKVIS MultiBrush.

- The button (only in the standalone version) creates a new file. The hot key for this operation is Ctrl+N (⌘+N on Macintosh).
The button (only in the standalone version) opens an image for processing. The hot key for this operation is Ctrl + O (⌘ + O on Macintosh).

Right mouse click on this button displays the list of recent files. You can change the number of recent documents in the program’s preferences.

The button (only in the standalone version) saves an image to the disk. The hot key for this operation is Ctrl + S (⌘ + S on Macintosh).

The button (only in the standalone version) prints the image. The hot key for this operation is Ctrl + P (⌘ + P on Macintosh).

The button lets posting pictures from the program to the social networks: Facebook, Twitter, Flickr, Tumblr, Google+.

The button shows/hides the alignment tools menu (guidelines, rulers, grids).

The button cancels the last action.

If you press this button several times, you can cancel several actions. The hot key for this operation is Ctrl + Z (⌘ + Z on Macintosh).

The button restores changes canceled by the action. The hot key for this operation is Ctrl + Y (⌘ + Y on Macintosh).

The button (only in the plugin version) applies the result to the image and closes the plugin.

The button shows information about the program.

The button opens the help files of the program. The hot-key is F1.

The button opens the Preferences dialog box for changing the program’s options.

At the left side of the Image Window there is the Toolbar. Tools are grouped in sets for convenience: Standard (available when working with a raster layer) and Artistic (available when working with an artistic layer). To quickly switch between the tool sets, use the hot key Q.

Parameters for the selected tool will be shown in a floating box over the Image Window (by right-clicking the mouse) and in the Settings Panel.

Under the tools in the Toolbar there is the color square with the current color. Click on it to open the Select Color dialog box and change the color.

On the right side of the program’s window you can see these sections:

1. Navigator;
2. Tools options;
3. Swatches and Color palettes,
4. Layers and Channels palettes,
5. History palette;
6. Hints

You can hide/show a section by clicking on its title.
Navigate and scale the image using the **Navigator**. With **Navigator** you can see the reduced copy of the image. The frame shows the part of the image that is now visible in the **Image Window**; the areas outside the frame will be shaded. Drag the frame to make other parts of the image visible. To move the frame, bring the cursor inside the frame, press the left mouse button and, keeping it pressed, move the frame in **Navigator**.

To scroll the image in the **Image Window** you can press the spacebar on the keyboard and drag the image with the left mouse button. Use the scroll wheel of the mouse to move the image up/down, by keeping the **Ctrl** (**⌘** on Macintosh) key pressed – to the left/to the right, by keeping the **Alt** (**Option** on Macintosh) key pressed – scale the image. Right-click on the scroll bar to activate the quick navigation menu.

Use the slider or the buttons + and −, to scale the image in the **Image Window**. When you click on the + button or move the slider to the right, the image scale increases. When you click on the − button or move the slider to the left, the image scale reduces.

You can also change the image scale by entering a new coefficient into the scale field and pressing the button **Enter** (**Return** on Macintosh). The fall-down menu shows some frequently used coefficients.

You can use hot-keys to change the image scale + and **Ctrl** + + ( **⌘** + + on Macintosh) to increase the image scale and − and **Ctrl** + − (**⌘** + − on Macintosh) to reduce the scale.

Under the **Navigator** there is the **Settings Panel** which offers the options for the selected tool and below the palettes: **Color** and **Swatches** (grouped together), **Layers** and **Channels** (which are grouped as well), and **History**. You can change the order of the palettes within a group by dragging them with the left button. **History** and **Channels** palettes are available in **Home Deluxe and Business** versions only.

Under the **Settings Panel** you can see **Hints** for the parameters and buttons when you hover over them with the cursor. You can show/hide the **Hints** section in **Preferences**.
HOW IT WORKS

**AKVIS MultiBrush** can work independently as a **standalone program** and as a **plug-in** to a photo editor.

Follow the instructions below:

- **Step 1.** Open an image or create a new image.
  - If you work with the standalone edition:
    
    Run the standalone edition of **AKVIS MultiBrush**.
    
    To open an image in the program, you can double-click in the empty workspace of MultiBrush or drag the image into the workspace, or press on the **Control Panel**.
    
    The program supports **BMP, JPEG, PNG, TIFF, PSD**, and **AKVIS** file formats.
  
  - If you work with the plugin:
    
    Run your photo editor. The MultiBrush plugin is compatible with Adobe Photoshop, Adobe Photoshop Elements, Corel Paint Shop Pro, and many other image editors.
    
    Open an image in your photo editor by calling the command **File -> Open** or using the key combination or using the key combination **(⌘ O** on Macintosh).
    
    Then call the **AKVIS MultiBrush** plug-in in the Filter/Effects menu of the photo editor. For example, in **Adobe Photoshop** select the menu item **Filter -> AKVIS -> MultiBrush**; in **Paint Shop Pro** select the menu item **Effects -> Plugins -> AKVIS -> MultiBrush**; in **Corel Photo-Paint** select the menu item **Effects -> AKVIS -> MultiBrush**.

![The AKVIS MultiBrush window](image)

- **Step 2.** Use the editing tools in the **Toolbar** to process the image (to learn how to use the editing tools in more detail, look at the examples).
Step 3. Save the processed image.

- If you work with the standalone edition:

  Click on the button 🎨 to open the Save as dialog box. Enter a name for the file, choose the format (TIFF, BMP, JPEG, PNG, PSD, or AKVIS) and indicate the target folder.

- If you work with the plugin:

  Apply the result by pressing ✓. The AKVIS MultiBrush plugin will close and the picture will appear in the workspace of the photo editor.

  Call the Save As dialog box using the command File -> Save As, enter a name for the file, choose the format and indicate the target folder.

**Note:** Use AKVIS format to be able to continue working with multi-layer file with all checkpoints and layers (raster, artistic, and text layers) without merging or rasterizing them. You can save the final result using JPG, TIFF, PNG formats, to be able to share it.

The standalone edition of AKVIS MultiBrush lets you print the image. For this purpose press the button 🖨️, adjust print settings, and press the Print button.
CREATING A NEW IMAGE

This is the **New Image** dialog window:

![New Image Dialog Window](image)

The **Presets** drop-down menu contains the standard file types which are used in printing or working on the internet. The **Size** menu shows the sizes available for this preset. All other parameters of the preset will be configured automatically. Typically, the preset will have a **Portrait** orientation, and the **Background Color** of the document will be white.

Any changes made to a preset’s parameters will change name on the drop-down menu to **Custom**, and the **Save Custom Preset** button next to it will become active. Press this button to save the current settings. A preset will be automatically assigned a name which can be changed in the illuminated field by entering any combination of letters and numbers. After pressing **Enter** a new preset will appear in the list. Any user preset can be deleted by selecting it and pressing the **Delete custom preset** button.

There are two possible orientations for a document - **Portrait** and **Landscape**. In **Landscape** an image is oriented horizontally (width is greater than height), while in **Portrait** it is oriented vertically (height is greater than width).

The size of the document can be set manually in the **Width** and **Height** fields. Units are listed in a drop-down list (pixels, inches, centimeters, millimeters, points, and picas).

The **Resolution** parameter specifies the density of pixels in an image (level of detail) and calculates the number of pixels per inch (ppi).

In **Color Mode** you can choose from one of the following color schemes: Grayscale, RGB, CMYK and Lab. The modes differ in how they handle color. After the color model has been defined, choose the color depth from the adjacent list: 8 Bits/Channel, 16 Bits/Channel or 32 Bits/Channel.

The **Transparent Background** option assigns a transparent background to the image, while the **Background Color** option allows the image to be filled with an opaque background color (the default is white). The color is selected in the **Select Color** dialog, which is activated by double-clicking on the adjacent color bar.
The button opens the Preferences dialog box. It looks like this:

![Preferences Dialog](image)

- **Language**: To switch the interface to another language, choose a language from the drop-down menu and press **OK**.
- **Initial Scale**: This option defines the way the image is scaled in the Image Window after opening. It can take one of two values:
  - image scaling **Fit to view**. The scale adjusts so that the image will be completely visible in the Image Window;
  - if the option **100%** is checked, image doesn’t scale. Generally, when the scale = 100%, only part of the image will be visible.
- **Remember Settings** check-box. Enable the check-box to keep the changes made to the settings (every time the program is launched).
- **Hot Keys**: Click on the button to open the dialog box where you can set up keyboard shortcuts for all tools and actions.
- **Hints Panel**: When you hover over parameters and buttons with the cursor you can see a brief description of them in the **Hints** field. You can choose how the hints will be shown:
  - **Under Image Window**. It shows the hints in the main window, under the image. This mode is useful if there is not enough space by height to display this field under the settings;
  - **Under Settings Panel**. Select this to show hints at the bottom of the right part, under the settings;
  - **Hide**. Use this option if you do not need the hints.
- **Recent Files** (available only in the standalone version). The number of recent documents. The list of the recent files, sorted by time, become visible by right mouse clicking on . Maximum: 30 files.
- **Use OS File Dialog** check-box. You can check this option if you want to use the System Open/Save Dialog. By default, the AKVIS File Dialog is used.
- **Lock the Control Panel** check-box. It disables the possibility to hide/show the top panel. If the check-box is enabled the panel is always visible. Uncheck the option to unlock the panel, and you will be able to hide/show it by clicking on the small triangle button (in the middle of the panel). The minimized panel will be shown when moving the cursor over it.
To save changes made in the **Preferences** window press **OK**.
Press **Default** to return to the default settings.
HOT KEYS

Some operations are faster and easier to perform with the keyboard, using so called "hot keys".
You can activate a tool by clicking on its icon with the mouse, change the size with the same mouse, or use keyboard combinations, which greatly speed up work. Hot keys are configured for the current set of tools.

How to customize your hot keys:

- Click on 🔄 to open the Preferences dialog box.
- Press on the Hot Keys button.

Below is a list of hot keys which work with AKVIS MultiBrush.

<table>
<thead>
<tr>
<th>Windows</th>
<th>Mac OS X</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Z</td>
<td>⌘+Z</td>
<td>Undo the previous action</td>
</tr>
<tr>
<td>Ctrl+Y</td>
<td>⌘+Y</td>
<td>Restore the previous action</td>
</tr>
<tr>
<td>+ or Ctrl++</td>
<td>+ or ⌘++</td>
<td>Zoom In</td>
</tr>
<tr>
<td>- or Ctrl--</td>
<td>- or ⌘--</td>
<td>Zoom Out</td>
</tr>
<tr>
<td>Ctrl+O</td>
<td>⌘+O</td>
<td>Open an image</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>⌘+S</td>
<td>Save the image</td>
</tr>
<tr>
<td>Ctrl+N</td>
<td>⌘+N</td>
<td>Create a new image</td>
</tr>
<tr>
<td>Ctrl+P</td>
<td>⌘+P</td>
<td>Print the image</td>
</tr>
<tr>
<td>F1</td>
<td>F1</td>
<td>Help</td>
</tr>
<tr>
<td>Q</td>
<td>Q</td>
<td>Quickly switch between the tool sets in the Toolbar</td>
</tr>
<tr>
<td>Ctrl+D</td>
<td>⌘+D</td>
<td>Deselect</td>
</tr>
<tr>
<td>Ctrl+A</td>
<td>⌘+A</td>
<td>Select All</td>
</tr>
<tr>
<td>Ctrl+Shift+I</td>
<td>⌘+B+I</td>
<td>Invert Selection</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>⌘+C</td>
<td>Copy to the clipboard</td>
</tr>
<tr>
<td>Ctrl+V</td>
<td>⌘+V</td>
<td>Paste from the clipboard</td>
</tr>
<tr>
<td>V</td>
<td>V</td>
<td>Switch between the Selection tools</td>
</tr>
<tr>
<td>Alt+C</td>
<td>Option+C</td>
<td>Crop</td>
</tr>
<tr>
<td>M</td>
<td>M</td>
<td>Move</td>
</tr>
<tr>
<td>T</td>
<td>T</td>
<td>Text</td>
</tr>
<tr>
<td>I</td>
<td>I</td>
<td>Eyedropper</td>
</tr>
<tr>
<td>Alt+H</td>
<td>Option+H</td>
<td>Hand</td>
</tr>
<tr>
<td>Z</td>
<td>Z</td>
<td>Zoom</td>
</tr>
</tbody>
</table>
**Standard Tools:**

- **B B** Color Brush
- **P P** Color Pen
- **A A** Spray
- **E E** Switch between **Eraser** and **History Brush**
- **S S** Clone Stamp
- **H H** Chameleon Brush
- **R R** Switch between **Blur**, **Sharpen**, and **Smudge**
- **L L** Switch between **Lighten**, **Darken**, and **Saturation**

**Artistic Tools:**

- **B B** Oil Brush
- **R R** Roller
- **F F** Felt-tip Marker
- **C C** Chalk
- **P P** Artistic Pencil
- **A A** Artistic Spray
- **E E** Artistic Eraser

**Tools Options:**

- `[]` and `[]` Change a tool's size (decrease and increase in increments of 5px)
- `Alt+D` and `Option+D` Reset the tool to default settings

**Additionally:**

- `Shift+click` and `0+click` Draw straight lines with pencils and brushes (only on the raster layer)
The standalone version of AKVIS MultiBrush lets you print the image. Just press the button on the Control Panel. The Print dialog box will be opened.

Print dialog box in AKVIS MultiBrush

The left part of the Print dialog box is the preview area where the current position of the image on the page is shown. On the right side of the dialog window the following print settings can be adjusted:

- **Printer**. If your computer is connected to a local network with many printers or if it is connected to many output devices itself, you will need to choose one of the available printers to print your image. Choose the desired print resolution from the Print Resolution drop-down list. The available choices will be based on those available for the printer you have chosen.

- **Orientation** of the printed image. There are two types of orientation available - Album and Portrait. Album corresponds to the horizontal page orientation (width is greater than height), while Portrait - corresponds to the vertical orientation of the paper.

- **Print Size**. To change the size of the printed image, adjust the parameters Scale, Width, Height and Fit to Page. These parameters have no effect on the image itself, just on the printed version. You can change the size of the printed image by entering any value in % (any value less than 100% will result in a smaller print size, and any value larger than 100% - will result in a larger print size), or by entering new values in Width and Height. If you want the size of the image to be adjusted to the paper size, then just select Fit to Page.

- **Move To**. Choose the position of the image on the page by clicking on one of the eight arrows.

The size of the printed image and its orientation can also be selected manually. A frame with markers is displayed around the image in the preview window. To change the size of the image move the cursor to one of the corner markers or to a side (the cursor changes in shape to a double sided arrow) and drag the marker or side. To change the position of the image on the page, bring the cursor over the image, press the left mouse button, and move the cursor.

Clicking the Page Setup button opens a dialog window in which you can choose the size of the paper and its orientation, as well as the print margins. To print an image with the chosen parameters, press the Print button. To cancel and close the printing dialog window press the Cancel button.
The Toolbar contains various tools to edit images: painting, retouching, toning, and other tools. To activate a tool click on its icon.

Tools are grouped in sets for convenience: **Standard** (available when working with a raster layer) and **Artistic** (available when working with an artistic layer). Press the hot key Q to quickly switch between the sets or use the Std/Art button at the top of the Toolbar. When switching between the sets, only one group is visible at a time. The arrows at the top enable you to display both groups at once. Below, in the left part, some additional tools are always visible.

The parameters for the selected tool will be shown in a floating box over an image (by right-clicking the mouse) and also in the Settings Panel. When you press the Default button (or use the shortcut Alt+D) the tool will be reset to its default settings.

Tools icons marked with a small triangle contain a submenu - a list with similar tools. To open this list either click with the right mouse button or click and then hold the left mouse button. After the submenu opens select the desired tool by left-clicking on it.
Under the tools there is the color square with the current color. Click on it to open the **Select Color** dialog box and change the color.
COLOR PALETTE

The current color selected in the **Color** palette is displayed on a large corner square. Left-clicking on the square opens the standard dialog **Select Color**. Right-clicking on the same box opens a menu of available color modes: Grayscale, RGB, CMYK, and Lab.

![Color Modes](image1)

By moving sliders or entering numerical values into the fields, one can change the individual color values of the selected color. At the bottom of the palette is a small spectral bar - bringing the cursor over this will cause it to take the form of an eyedropper. To choose a color just click the eyedropper on the bar.

![Color Palette](image2)

The empty squares at the top right area of the palette are used to store frequently used (custom) colors. To add a color to the mini-palette just drag it from the current color box to a square of custom colors or double-click the left mouse button on a square and select a color from the **Select Color** dialog. To change the main color to that in a box, left-click on a box. To remove the color from a box, right-click on it.
**SWATCHES PALETTE**

The **Swatches** palette contains a collection of frequently used colors. Select a color from the collection by clicking the left mouse button, and it will be set as the main color. Press the right mouse button to access the palettes settings, which duplicate the functions of the buttons at the bottom of the palette.

The empty squares at the top right area of the palette are used to store custom colors. To add a color to the mini-palette just drag it to a square or double-click the left mouse button on a square and select a color from the **Select Color** dialog. To change the main color to that in a box, left-click on a box. To remove the color from a box, right-click on it.

The buttons at the bottom of the palette have the following uses:

- The **Add Swatch** button adds the current color to the collection of swatches.
- To delete a color drag it to the basket or choose **Delete Swatch** from the menu.
- The **Load From File** button loads a saved collection of swatches (files ending in `.swatches`) so that they can be used again.
- The **Save Into File** button opens a dialog where swatches can be saved.
- The **Reset Defaults** button resets the collection of swatches to their original settings.
HISTORY PALETTE

The History palette is available in Home Deluxe and Business versions only.

The History palette shows the list of every change made to a file. By clicking on an item in the list, you can revert the file to a previous state.

At the top of the palette, near a thumbnail of the image, there is information about the file: its name, size (in pixels), color mode, profile, and date and time of creation.

The history of changes is arranged in a linear fashion. This means that if you return to any intermediate state and apply an action, all actions on the list after it will be permanently removed, except for the control points (which will be placed at the top of the list). Selecting Open from the list returns the file to its initial state (before changes were applied).

All changes made are shown with their corresponding icon. Any successive changes made by the same tool (two or more) are arranged in a group; the number of elements in a group is shown by a grey number to the right of the icon. The list of elements in a group can be collapsed and reopened by pressing the "+" to the left of the tool's icon.

The following buttons are at the bottom of the History palette:

- The button Undo/Redo Position State and switches between two states in the list. In contrast to the buttons and that allow moving one step back/forward on the list, this button allows restoring the history after the last change. Use this button if you want to restore the history after the commands Delete States or Collapse Group.

- The button Exit mode is active in the Artistic Cloning only. It allows quitting the mode without applying the changes.

- Individual states on a list can be preserved using checkpoints, with the Create Checkpoint button. Each control point that is added is given a name in succession (Checkpoint 1, Checkpoint 2, etc). The checkpoint no longer has the history of that element but retains the change made to it.

  To rename a checkpoint, double left-click on the checkpoint’s name, enter a new name and press Enter (Macintosh: Return).

- By pressing the button Delete States all states below the selected one will be removed and all checkpoints will be brought to the top of the list. If this button is pressed while a checkpoint is selected, the checkpoint will be deleted.
The **Collapse Group** button collapses the list in a group and combines it into one state, removing the individual history of each element. After this button is pressed individual elements in a group cannot be edited.
LAYERS PALETTE

The **Layers** palette lets you work with layers (sets of pixels which can be edited separately) and groups of layers.

![Layers Palette](image)

The palette contains a list of layers. Until an image is opened in the program or a new document has been created, this list will be empty.

The active (editable) layer will be highlighted in gray in the list. To choose another layer, click on its name or thumbnail. To choose multiple layers, click on them while holding **Ctrl**. To choose all layers between the active and chosen layers, while the active layer is highlighted, click on the chosen layer while holding down **Shift**.

To rename a layer, double left-click on the layer's name next to it's thumbnail, then enter a new name and press **Enter**.

To the left of a layer's thumbnail is a visibility indicator ☐/☐, which can be used to temporarily hide or show the contents of a layer. Editing tools cannot be used on a layer when its visibility is switched off. To switch a layer's visibility left-click on the indicator.

**Note 1:** The layers in a group are visible only if that group's visibility is activated (regardless of the visibility of individual layers).

**Note 2:** When a file is saved to a format which does not support layers, invisible layers are discarded.

Layers are either **Raster** or **Artistic**. Each type of layers has its own set of tools (**Std** or **Art** in the toolbar). An artistic layer will be labelled **Art** on its right side (see the screenshot above). Also, there is a **Text** layer which is used for adding text. To use the standard tools on an artistic/text layer you need to rasterize it first.

The order of the layers can be changed by dragging them up or down while pressing the right-mouse button.

Right-clicking on a layer opens a menu of commands. The menu's contents may vary depending on the type of layer and the number of selected layer.
Blending Options opens the **blending options** menu.

Layer Properties opens a separate menu of **parameters for an artistic layer**.

Duplicate copies the selected layer or group.

Delete deletes the selected layer or group (analogous to ![Trash]).

Rasterize Layer converts any layer to a regular (raster) layer.

Group Layers combines selected layers into a group (analogous to ![Group]).

Ungroup Layers quickly separates layers from the selected group.

Show/Hide enables/disables the display of the contents of layers/groups.

Merge Group merges all visible layers in a group to one layer. The new layer will appear in the list in place of the group.

Merge Visible combines all visible layers into one layer.

Merge All combines all visible layers, discarding the invisible ones, into one layer.

Bring to Front moves the selected layer to the top of the list.

Bring Forward swaps places between the selected layer and the layer above it.

Send Backward swaps places between the selected layer and the layer below it.

Send to Back moves the selected layer to the bottom of the list.

To the right of a layer's name there is a lock icon. Click on it to open a menu with the buttons which represent various levels of protection of the layer from changes.
Unlock - this icon means the layer is in an unlocked state (available for changing).

Lock Image Pixels protects the opaque pixels on a layer from any changes made by drawing/editing tools.

Lock Transparent Pixels (only for raster layers) prevents changes to the transparent pixels on a layer.

Lock Position prevents a layer from being moved.

Lock All prevents any changes to a layer.

Double-clicking on a layer's thumbnail opens the Blending Options menu. Close the menu by pressing Esc (changes will be ignored) or by clicking outside of the menu window (changes will be saved).

The Blending Options menu looks like this:

- **Blend Mode** provides ways to blend the pixels on one layer with those on the layer below it (read more).

- **Opacity** (0-100) affects the visibility of other layers below the selected layer. If a layer has an opacity of 0%, it will be completely transparent (invisible). An intermediate value of opacity results in partial permeability of the pixels on that layer. At 100% opacity only the pixels on that layer are visible. Transparent and translucent areas are filled with a checkerboard pattern.

  For blend modes other than normal, **Opacity** affects to what extent they are involved in forming a blended image.

- **Channels** mode controls independent color channels. Clicking on a check box determines which color channels will be involved when blending layers.

- **Blend by Brightness** controls the visibility of pixels on the active layer and layers below it based on their brightness (read more).

If you click on the word Art on an artistic layer in the list, the Layer Properties menu will open:

- Activating the **Background** check box fills the layer with a color.

  **Opacity** (1-100) controls how much the background color will be mixed with the colors of pixels in underlying layers.
**Transition** (0-100) controls the ratio of colors in a background fill. The higher the value for this parameter, the more dominant the first color will be. To change the color, click on the color plate and choose a color from the **Select Color** dialog window.

The buttons at the bottom of the palette are used as follows:

- **The New Group** button \(\square\) allows you to combine multiple layers into one set. When you click on this button in the **Layers** palette, elements will be created named Group 1, Group 2, etc., each with a folder icon \(\square\). By moving a folder you can move all of the layers within it together.

To add a layer to a group, drag it to the folder while holding down the left mouse button and release it when it is above the folder. You can remove a layer from a group in a similar way. If you drag the folder to the \(\square\) button at the bottom of the palette, a copy of the folder along with its sub-layers will be created.

To group multiple layers at once, select them and press the \(\square\) button. The layers will automatically be combined into a new group.

To rename a group, just double click on its name, enter a new name and press \(\text{Enter}\).

If a group is not empty (contains layers), a triangle \(\triangle\) will appear on it. Double clicking on the triangle allows you to open or close the group. When a group is open \(\checkmark\), its constituent layers can be moved, deleted, or edited individually.

You can change a **Blend Mode** for a **group** of layers. By default, the **Pass Through** mode is selected for a group in the **blend modes list**, that is the layers inside the group interact with each other (and the layers below) in the usual way - as if they are not grouped. When other blend modes are used, the group behaves as if all layers inside it are combined into one layer, which interacts with the layers outside the group based on the chosen blend mode. In this case, blend modes of individual layers in the group are valid only within that group, and have no affect on layers outside of the group.

- **The New Layer** button \(\square\) creates a new layer above the active layer or in the active group. When you create a new layer a pop-up menu will appear, where you can choose the layer type, either **Raster** or **Artistic**. If you drag a layer (or group) to this button while holding the left mouse button and then release the left mouse button, a copy of that layer (or group) will be created.

- **The Delete** button \(\square\) deletes the selected layer or group. When a group is dragged to this button the group along with all of its contents will be deleted. If a group is selected, and then the button is pressed, it's possible to delete the group with or without its content (your choice).

**Note:** It is impossible to delete all layers.
BLEND MODES

Blend modes let you mix the color and brightness of image layers. Below is an example of what can be achieved when combining two layers:

The program has 16 blend modes. Each layer is set to Normal by default.

A blend mode can be chosen for a set (group) of layers. If Pass Through is chosen from the blend mode drop-down list, then layers in a group will interact with each other and layers below in the usual way, as if they are not grouped. If another blending mode is chosen the set behaves as if the layers have been merged into one layer, which interacts with layers outside of the group based on the chosen blend mode. In this case the blend modes applied to individual layers within a set are only valid within the group and do not affect layers outside of the group.

Basic Modes

- **Normal.** No interaction occurs between the active and the lower layer, ie all pixels on the upper layer are displayed as usual. Blending in this mode can only be achieved by adjusting Opacity.

- **Dissolve.** This works when Opacity is less than 100%. Lowering opacity randomly conceals pixels on the top layer, and pixels from the lower level are shown in their place.
Darken Modes

- **Darken.** In this mode the top layer appears to be darker in color than the lower layer. Dark pixels on the upper layer will remain unchanged, while the white color will be transparent. The resulting image is derived from the least bright pixel values for each channel.

- **Multiply.** The upper layer darkens the lower layer. Colors are combined in such a way that they become denser. The image darkens. The white color will be transparent. This mode can be used to restore faded or overexposed photos, impose shadows, or imitate a felt-tip marker.
Color Burn. In this mode, contrast is increased by blending the darker pixels on the lower layer with the color of the upper layer. White pixels on the layer become transparent. Shadows in this mode are more intense than in Multiply. It is often used to increase saturation in light areas, tinted glass, precious stones, in underlining details of collages, and to imitate the effect of Burn on an image.

Lighten Modes

- **Lighten.** In this mode the brighter areas of the top layer replace darker areas on the lower layer. Brighter pixels on the upper layer will remain unchanged, while black pixels will become transparent. The result is based on the brightest pixel values of both layers.
- **Screen.** The upper layer brightens the lower, depending on its brightness. The black color on the upper layer becomes transparent. This mode can be used to brighten dark images, simulate glow, to blend an image with the lower layer, and with different types of glare.

- **Color Dodge.** In this mode the image on the lower layer is brightened by decreasing contrast based on the color of the upper layer. The black color on the upper layer becomes transparent. The effect on light areas is even stronger than **Screen** mode. This mode can be used to create bright flashes and to match the contrast of an image with the background.
- **Linear Dodge.** It works like **Color Dodge** with less effect.

**Contrast Modes**

- **Overlay.** This mode combines the effects of **Multiply** and **Screen** modes, blending the upper layer with the lower. The result depends on the brightness of pixels in the blended layers: if the pixels of the lower layer are darker than those on the upper layer, the image becomes darker (Multiply), if they are lighter than those on the upper layer, the image is lighter (Screen). It is well suited for enhancing low contrast detail and superimposing texture on an image. If the color of the top layer is gray (50%) there will be no effect.
- **Soft Light.** The image is brightened based on the brightness of the upper layer. If the pixels on the upper layer are brighter than neutral (50%) gray the image is brightened; if they are darker than neutral gray, then the lower layer is darkened. If the top layer is neutral gray (exactly 50%), there is no effect. This mode is useful for adjusting the tones of a background when making a collage, so that an object inserted above the background will gently blend with it.

- **Hard Light.** Similar to the previous mode, the image is darkened (Multiply) if the pixels on the upper layer are darker (darker than neutral gray), and lightened (Screen), if those pixels are lighter (lighter than neutral gray). The contrast of colors is higher than in Soft Light mode. If the upper layer is neutral gray (exactly 50%), there is no effect. This mode is useful for making the background texture of the lower layer visible on the upper layer.
Comparative Modes

- **Difference.** This mode displays the tonal difference between the contents of two layers. Colors are inverted based on the brightness of pixels on the upper and lower layers. If the color of the upper layer is white the colors of the lower layer are inverted, if it is black there no change. If the combined layers are not too dark or bright and are sufficiently saturated, some interesting effects can result. This mode can also be used to compare two images - if they differ by even one pixel, it will be displayed in black.

- **Exclusion.** Similar to the previous mode, the inversion of color is determined by the brightness of pixels on the upper and lower layers. Pixels of intermediate colors will be shown in gray, reducing contrast. Blending with white inverts the colors of the lower layer; blending with black has no effect. This mode is useful for achieving various effects.
- **Subtract.** In this mode, the final pixel color is determined by the difference between the color values of pixels in the layers. If the result of the subtraction is negative, the pixel becomes black.

- **Divide.** The result color is obtained by dividing the color values of the lower pixels by the color values of the upper pixels. If we apply to the image its copy, it will turn completely white.
BLEND BY BRIGHTNESS

The Layers' **Blending Options** are arranged in two groups of parameters: **General** and **Blend by Brightness** (advanced).

**Blend by Brightness** is used to control the visibility of pixels on the active layer (This Layer) and the lower layer (Underlying Layer) based on their brightness. Each scale has two sliders. At the leftmost slider a pixel has a brightness of 0 (black); at the extreme right a brightness of 255.

Those pixels whose brightness falls within the values between the two sliders will be displayed (for the upper layer) and hidden (for the lower layer). Sliders hide pixels without removing them.

If a slider is moved while holding down `Ctrl`, the slider will be divided into two parts, which can then be moved independently of one another. Divided sliders set the tonal range between visible and invisible pixels, so you can achieve a more subtle effect with a soft color change.

Actions on the active layer (**This Layer**):

- **Upper (This) Layer**
- **Lower Layer**

**Moving the left slider hides dark pixels with lower brightness**

**Moving the right slider hides light pixels with higher brightness**

![Images and diagrams related to Blend by Brightness settings.](Images)
Actions on the lower layer (Underlying Layer):

Moving the left slider makes the darker pixels of the lower layer visible on the upper layer, if their brightness is less than the specified value.

Moving the right slider makes the lighter pixels of the lower layer visible on the upper layer, if their brightness is more than the specified value.
Moving the sliders to the center makes pixels from the lower layer visible on the upper layer whose brightness values fall outside the range marked by the sliders.
The **Channels** palette is only available for Home Deluxe and Business licenses.

This palette lets you view and edit the image in separate channels. A channel is a halftone image that contains the brightness information of component colors.

The channels list contains: 1) the composite image (RGB, CMYK, Lab, or Grayscale), 2) the separate channels for the color mode (for example, for RGB - Red, Green, Blue channels), 3) the current raster layer transparency (alpha channel), and 4) the current selection channel.

To the left of a channel's name there is a visibility indicator and a thumbnail which displays all changes made with this channel.

The active (editable) channel will be highlighted with a dark gray background in the list. To select another channel click on its name.

When you select one of the component channels (for example, blue in RGB) the image will be shown as grayscale in the Image Window.

The visibility indicator near the inactive channel means that this channel is shown in the Image Window but is not editable.

If several channels are visible, the image will be displayed in colors.
If you select the composite channel, all component channels become visible and active. The composite image is always located at the top of the list and is selected by default.

To edit a channel, use the usual drawing tools. Painting in the color white on a channel will result in 100% intensity of the corresponding color. Different shades of color result in varying color intensity. A black brush will completely remove a color channel.

In the Alpha channel, by default, opaque areas are shown in white, transparent areas in black, and semitransparent areas in gray.

You can adjust the view mode for the alpha channel in the pop-up menu: Grayscale, Trimap, and Highlighted in Red.
For the Selection channel you can switch between 6 view modes: **Grayscale, Trimap, Highlighted in Red, Inverted Red, Black Background, and White Background.**
COLOR BRUSH

The **Color Brush** is used to draw free-form lines with soft borders. Using this tool, you can draw either a clear or blurry line, but they will always be soft. Press B to quickly access this tool.

The tool’s parameters will be shown in a floating box over an image (by right-clicking the mouse) and in the **Settings Panel**.

In order to change a parameter's value, enter a numerical value in the box next to a parameter and press Enter (Macintosh: Return) or adjust the slider.

- **Size** (1-1000). The maximum width of a line which can be drawn with the brush (in pixels).
- **Hardness** (0-100). The amount of blurriness of the outer edge. The higher the value of this parameter, the harder the edge of the brush becomes. At almost 100%, the brush draws almost as hard as a pencil; while at a lower value the transition from the edge to the background is processed more smoothly.

**Birth of a White Giant**
(thé circle shows the real size of the brush = 160)

![Hardness = 60%](image1)
![Hardness = 15%](image2)

- **Blend Mode**. It defines how the brush strokes blend with the background. The program provides 16 blend modes.

![Screen Mode](image3)
![Overlay Mode](image4)

- **Opacity** (1-100). Opacity of the brush strokes in relation to the background color. As the value is decreased, the line becomes paler and its interaction with the background grows stronger.

**Colorizing a Snowflake with a White Brush**
(Size = 6, Hardness = 85%)
Spot Spacing (5-200). Distribution of elements, from which the line is comprised. Increasing this parameter creates a line that is composed of a series of circles; the distance between the circles depends on the parameter’s value.

Drawing with Spaces

- Spot Spacing = 65
- Spot Spacing = 70 and 104

- Aspect (1-100). The compression of the brush tip. At value = 1 the brush is flattened into a line, at 100 it is a circle, and at intermediary values it is an ellipse. The lower the values for this parameter, the longer the ellipse, along the angle specified by Angle.

- Angle (0-180). The rotation angle of the brush.
**Noise check-box.** Adds noise to a soft edge brush. At a lower value of **Hardness** and higher value of **Spot Spacing**, more noise can be obtained.

**The Appearance of Snow on a Branch**
(Hardness = 0%, Opacity = 100%, Spot Spacing = 30)

The color of the brush is changed in the **Color/Swatches** palettes. To change the color of the brush place the cursor over the spectral strip (the cursor takes the shape of a dropper) and click on the desired color or click on the square and select a color using the standard dialog **Select Color**. In some cases it may be more convenient to change the color manually, which can be done by adjusting the sliders.

To draw a straight line, first specify the starting point with the left mouse button, then, while keeping **Shift** pressed, move the cursor to the desired end point of the line and release **Shift**. If **Shift** is not released, a new line will be drawn to each point where the mouse is clicked.
COLOR PENCIL

The **Color Pencil** is designed to draw free-form lines with hard edges. Press \[p\] to quickly access this tool.

The tool’s parameters will be shown in a floating box over an image (by right-clicking the mouse) and also in the **Settings Panel**.

To change the value of a parameter, enter a numerical value in the field next to the parameter and press \[Enter\] (Macintosh: [Return]) or move the slider.

- **Size** (1-1000). The maximum width of a line made by the brush (in pixels).
- **Blend Mode**. It defines how the pencil strokes blend with the background. The program provides **16 blend modes**.

![Normal Mode](image1.png) ![Overlay Mode](image2.png)

- **Opacity** (1-100). The opacity of the pencil's strokes in relationship to the color of the background. This parameter sets the opacity color, by which a line is drawn: at lower values, the color of the line is paler and its interaction with the color of the background increases.

![Painting of a Ballerina Figure With the Pencil](image3.png)

- **Spot Spacing** (5-200). Distribution of elements, from which the line is comprised. Increasing this parameter creates a line that is composed of a series of circles, the distance between the circles depends on the parameter’s value.

![Drawing With Spaces](image4.png)
Aspect (1-100). The compression of the pencil tip. At value = 1 the it is flattened into a line, at 100 it is a circle, and at intermediary values it is an ellipse. The lower the values for this parameter, the longer the ellipse, along the angle specified by Angle.

Application of War Paint on a Native’s Face

- Aspect = 30
- Aspect = 80

Pattern on a Vase

- Angle = 30
- Angle = 140

The pencil's color is set in the Color/Swatches palettes. To choose a color bring the cursor over the spectral line (the cursor takes the form of a pipette) and click on the desired color or click on the box and choose a color from the standard dialog Select Color. In some cases it might be preferable to select a color manually, by adjusting the sliders.

In order to draw a straight line, click the left mouse button at its starting point, then, press Shift, click on the end point, and let go of Shift. If Shift is not released, a new line will be drawn to each point where the mouse is clicked.
The Spray brush imitates spraying paint on an image. It does not apply paint in a continuous layer but rather as droplets scattered along the stroke. Press \texttt{A} to quickly access this tool.

The tool's parameters will be shown in a floating box over an image (by right-clicking the mouse) and also in the Settings Panel.

To change the setting of a parameter, enter a numerical value in its box and press Enter or move the slider.

- **Size** (1-1000). The maximum width of a line made by the brush (in pixels).
- **Opacity** (1-100). The permeability of brush strokes in relation to the background color. This parameter sets the opacity of paint applied to the image: at lower values drop color becomes lighter and interacts more with the background color.

  **Revealing Freckles on a Child’s Face**
  
  (Size = 55, Drop Density = 5, Drop Size = 4)

- **Drop Density** (1-100). The amount of spots in a stroke. At higher values of this parameter the spray becomes denser.

  **Spraying With Varying Density**
  
  (Size = 175, Opacity = 100\%, Drop Size = 9)

- **Drop Size** (1-50). The diameter of individual drops. Larger drops will merge, forming an irregularly shaped line with rough edges.

  **The Arrival of Winter**
  
  (Size = 400, Opacity = 100\%, Drop Density = 1)
Intensity (1-100). The intensity of drop color in a single stroke. As drops are sprayed their interaction with one another increases. The lower the value of this parameter, the paler the paint color.

Adding Blush to a Girl’s Cheeks
(Size = 52, Opacity = 100%, Drop Density = 100, Drop Size = 1)

Intensity = 5
Intensity = 70

Paint color is set in the Color/Swatches palettes. To choose a color bring the cursor over the spectral bar (the cursor will take the form of a pipette) and click on the desired color or double-click on the square and choose a color from the Select Color dialog. In some cases choosing a color is more convenient than manually selecting the components of a color with the sliders.

To spray paint along a straight line, Left-click to set the starting point, then hold down Shift, move the cursor, click on and end point and release Shift. If Shift is not released, the line will be drawn following all selected points.
The **Eraser** is a tool that alters the transparency of an image (on the selected raster layer). Processed sections are shown as transparent areas, with a checkerboard background. To quickly access this tool and switch between the **Eraser** and **History Brush** tools press \[E\].

**Attention!** When saving a file into a format that does not support transparency (JPEG), the transparent areas will be replaced by white. To keep the transparency, use **PNG** format.

The tool's parameters will be shown in a floating box over an image (by right-clicking the mouse) and also in the **Settings Panel**.

To change the value of a parameter, enter a numerical value into the parameter's field and press \[Enter\] (Macintosh: \[Return\]) or adjust the slider.

- **Size** (1-1000). The maximum width of the transparent line which the eraser leaves behind (in pixels).
- **Hardness** (0-100). The amount of blurriness of the brush's edge. As the value of this parameter increases the edge of the brush becomes harder. Near 100% the border between erased and unerased areas will be more distinct; at lower values the boundary between these areas will be smoother.

**Removing Some of the Drawing With the Eraser**

![Hardness = 100%](image)

![Hardness = 20%](image)

- **Strength** (1-100). The amount of influence on an image. As this parameter's value is increased, the degree of transparency left by the brush increases.

**Removing the Boundary With the Eraser**

![Strength = 100%](image)

![Strength = 45%](image)

- **Color Sampling**. When the check-box is disabled, the tool removes pixels of all colors. Activate the check-box to erase certain background colors. When you click with the eraser, it samples the color and uses it.
- **Tolerance** (1-100). This parameter becomes active when the **Color Sampling** check-box is enabled. It lets you adjust (reduce or expand) an area to be removed. At low values, the tool deletes colors similar to the pixel you click on. The higher the value, the wider the range of removable colors will be.

![Color Sampling is disabled](image1.png) ![Color Sampling is enabled](image2.png)

In order to erase in a straight line, select the starting point of the line with the left mouse button, then, press and hold down **Shift**, move the cursor to the desired endpoint, and release **Shift**. If **Shift** is not released, then successive lines will be drawn to each point where the mouse is clicked.
HISTORY BRUSH

The **History Brush** returns an area of an image to its original condition, where another tool had been applied. The difference between the tools **Eraser** and **History Brush** is the latter removes all effects, but does not affect the background. To quickly access this tool and switch between the **Eraser** and **History Brush** tools press **E**.

The tool's parameters will be shown in a floating box over an image (by right-clicking the mouse) and also in the **Settings Panel**.

To change the value of a parameter, enter a numerical value in the parameter's field and press **Enter** (Macintosh: **Return**) or adjust the slider.

- **Size** (1-1000). The maximum width of a line made by the brush (in pixels).
- **Hardness** (0-100). The degree of blurriness of the brush's edges. As the value of this parameter is increased the brush's edges become harder. At values near 100% the border between the brush's edges and the background is very distinct; at lower values the transition between these areas is smoother.

**Restore the Painted Over Branches With the History Brush**
(Size = 100, Strength = 100%)

"Cleaning" Dust From a Mirror

**Strength** (1-100). The degree of restoration to the original state. At lower values there will be less restoration and more blending with the effect; at values near 100% the original condition will be restored more completely.
The **Clone Stamp** tool can clone a part of an image from one part and into another while maintaining the original color range, shadows, and other characteristics of the cloned part. Press \( \text{S} \) to quickly select this tool.

To clone an object, **first select the area to be cloned**: do this by first holding down \( \text{Alt} \) (Option on Macintosh), and then clicking on the area from which the clone will be taken.

Once the reference point is defined, place the cursor over the area you wish to place the clone. When you left-click a cross-shapped cursor will appear over the source image, identifying the original fragment.

The tool's parameters will be shown in a floating box over an image (by right-clicking the mouse) and also in the **Settings Panel**.

To change the value of a parameter, enter a numerical value in the parameter’s field and press \( \text{Enter} \) (Macintosh: \( \text{Return} \)) or adjust the slider.

- **Size** (1-1000). The maximum diameter of the source used for cloning (in pixels).
- **Hardness** (0-100). The degree of blurriness of the fragment’s edges. At higher values of this parameter, the less the fragment’s border interacts with the background. At values near 100% the border between the fragment and the image is very distinct; at lower values the border between these areas will be smoother.

**Cloning Red Berries With Stamp of the Same Size**

- **Hardness = 30%**
- **Hardness = 100%**

- **Blend Mode**. It defines how the cloned fragment blends with the background. The program provides 16 blend modes.

**Cloning with Different Blend Modes**

- **Normal Mode**
- **Overlay Mode**

- **Opacity** (1-100). The opacity of the fragment in relation to the background. This parameter
affects the opacity of the fragment where it is stamped: at lower values, the fragment is paler and its interaction with the background is greater.

**Cloning Glass Eggs** (example by Gun Legler)

- **Opacity of the Clone = 40%**
- **Opacity of the Clone = 100%**

- **Aligned** check-box. This option sets how the fragment is cloned. When the check-box is activated, a single clone will be created using information from around the selected source: in this case each time the left mouse button is pressed a clone will be selected from the relevant area. When the check-box is not activated, each time the mouse button is released the cursor returns to the source area, and new clone fragments are created from this same area.

**Cloning Methods**

- **Aligned check-box is enabled**
- **Aligned check-box is disabled**

- Activating the **Flip Horizontal** check-box allows a clone to be mirrored along the standing axis, i.e. interchanging the left and right sides.

- Activating the **Flip Vertical** check-box mirrors a clone by turning the image upside down.

**Flipping Clones**
Scaling (20-400%). The size of the clone relative to the original fragment.

**Clone Scaling**

- **Scaling** (20-400%). The size of the clone relative to the original fragment.
CHAMELEON BRUSH

The Chameleon Brush copies a fragment of an image from one part to another with respect to the color range, tone, texture, illumination, and other characteristics of the background, to which the clone is applied. Unlike the Clone Stamp tool, this preserves the characteristics of the underlying image. Press \[H\] to quickly select this tool.

Cloning While Maintaining Illumination of Background (Example by Gun Legler)

![Fragment on a Dark Background](image1.png) ![Fragment on a Light Background](image2.png)

Cloning Glass Eggs (example by Gun Legler)

![The original image of the crystal egg](image3.png) ![Two clones of the crystal egg](image4.png)

To clone an object first choose Chameleon Brush from the left, and select an image source by holding down \[Alt\] (\[Option\] on Macintosh), and click the left mouse button over the area from which the cloned fragment will be selected.

Once the reference point is defined, move the cursor to another location. To place the cloned fragment click the left mouse button. When the left mouse button is released, a cross-shaped cursor will appear over the source area, to indicate from where the clone fragment is selected.

The tool’s parameters will be shown in a floating box over an image (by right-clicking the mouse) and also in the Settings Panel.

To change a parameter, enter a numerical value in the parameter’s field and press \[Enter\] (\[Return\] on Macintosh) or use the slider.

- Size \((1-1000)\). Diameter of the source area, from which the fragment is cloned (in pixels).
- The check-box **Aligned**. This parameter sets the cloning method. When the check-box is activated one clone is created from an area: in this case each new line draws information from the relevant area around the source point. When the check-box is deactivated, each time the mouse button is clicked, a cross-shaped cursor will appear above the source area, and new lines will create a clone from only this area.

- Activating the **Flip Horizontal** check-box allows a clone to be mirrored along the standing axis, i.e. interchanging the left and right sides.

- Activating the **Flip Vertical** check-box mirrors a clone by turning the image upside down.

- **Scaling** (20-400%). The size of the clone relative to the original fragment.

- The check-box **Artistic Cloning** temporary disables the consideration of the neighboring pixels when applying a clone fragment. In this mode you can change size of the brush, choose a new source from which to copy a clone, remove parts from a clone area, etc.

  To remove a part of the clone, press the Ctrl-key on the keyboard (⌘ on Macintosh) and, keeping it pressed, draw over the area. This is useful when cloning from a large image or creating a clone from different parts of an image. The clone will be processed after is pressed.
The **Blur** tool reduces image sharpness by decreasing color contrast between neighboring pixels. To quickly access this tool and switch between the **Blur**, **Sharpen**, and **Smudge** tools press R.

The tool's parameters will be shown in a floating box over an image (by right-clicking the mouse) and also in the **Settings Panel**.

To change the value of a parameter, enter a numerical value in the parameter’s field and press Enter (Macintosh: Return) or adjust the slider.

- **Size** (1-200). Blur brush size (in pixels).
- **Hardness** (0-100). The width of the tool’s outer edge, where the image is partially blurred. The higher the value, the larger the area within the brush where blur is applied completely.
- **Radius** (0.1-5.0). Intensity of the effect on an image. This parameter specifies the area where points are searched for blurring: at higher values the blurring radius is larger.

To blur the image along a straight line, left-click to choose a starting point, then, while pressing Shift, move the cursor to where the end point will be and left-click, then release Shift. If Shift is not released, a new line will be drawn to each point where the mouse is clicked.
**SHARPEN**

The **Sharpen tool** improves the clarity of an image by increasing the color contrast between pixels. To quickly access this tool and switch between the **Blur**, **Sharpen**, and **Smudge** tools press **R**.

The tool’s parameters will be shown in a floating box over an image (by right-clicking the mouse) and also in the **Settings Panel**.

To change a parameter enter a numerical value in the parameter’s field and press **Enter** (Macintosh: **Return**) or adjust the slider.

- **Size** (1-500). Sharpen tool size (in pixels).
- **Hardness** (0-100). The width of the tool's outer edge, where sharpness is partially applied. At higher values the amount of sharpness applied to the inner area of the tool increases.

![Hardness = 30%](image1.png) ![Hardness = 95%](image2.png)

- **Amount** (1-250). The amount of contrast between pixels. At a value of 100% contrast is increased 2 times, at 200% by 4 times, etc.

**Changing Sharpness By Adjusting Contrast**

![Amount = 20%](image3.png) ![Amount = 210%](image4.png)

- **Radius** (0.1-20.0). The degree of edge sharpness. This parameter specifies the number of neighboring pixels that are affected by the sharpness of a pixel. When the value is increased, the intensity of transition between colors increases.

**Increasing Clarity by Adjusting the Amount of Edge Sharpness**
To enhance sharpness along a straight line, select a starting point with the left mouse button, then, while keeping Shift pressed, move the cursor to the end point and release Shift. If Shift is not released, a new line will be drawn each time the mouse is clicked over the image.

Radius = 3.0

Radius = 18.0
The Smudge tool mixes colors by displacing pixels, like a finger passing through wet paint. To quickly access this tool and switch between the Blur, Sharpen, and Smudge tools press R.

The tool's parameters will be shown in a floating box over an image (by right-clicking the mouse) and also in the Settings Panel.

To change the settings for a parameter, enter a numerical value in the parameter's field and press Enter or adjust the slider.

- **Size** (1-300). Width of the Smudge Tool.
- **Hardness** (0-100). The degree to which the tool smears. At higher values of this parameter, the more streaks are smeared the sharper the line's edges are.

  **Mop-headed Boy**

  ![Hardness = 10%](image1) ![Hardness = 90%](image2)

- **Strength** (1-100). The lengthiness of a stroke's colors. The higher the value of this parameter, the more the element is smeared.

  **Growing Canines**

  ![Strength = 30%](image3) ![Strength = 60%](image4)

- **Use Color** (0-100). Intensity of primary colors at the beginning of each stroke. The higher the value, the brighter the color at the beginning of the stroke. If this parameter is set to zero the stroke will be applied in the normal way (without using the primary color).

The primary color can be selected in the Color/Swatches palettes. To select a color move the cursor to the spectral strip (the cursor will take the form of a pipette) and click on the desired color, or choose a color from the standard color dialogue Select Color. In some cases it is more convenient to change colors manually, by adjusting the sliders.

**Appearance of a Flame**
To spread color along a straight line, first select a starting point by clicking the left mouse button and while holding **Shift**, move the cursor to the desired endpoint and release **Shift**. If **Shift** is not released, then new lines will be drawn to each point where the mouse is clicked.

Use Color = 20

Use Color = 75
**LIGHTEN**

The **Lighten** tool tones an image by enhancing the brightness of colors. Each stroke applied increases the lightening effect. To quickly access this tool and switch between the Lighten, Darken, and Saturation tools press \[L\].

The tool’s parameters will be shown in a floating box over an image (by right-clicking the mouse) and also in the Settings Panel.

To change the value of a parameter, enter a numerical value in the parameter’s field and press \[Enter\] (Macintosh: \[Return\]) or adjust the slider.

- **Size** (1-1000). Diameter of the Lighten Tool.
- **Hardness** (0-100). The degree of softness of the tool’s edge. The higher the value, the sharper the tool’s edge are. At 100% there is a sharp transition between the affected area and the unaffected area; at lower values the transition between these areas is smoother.

**Lighten Used to Smooth Transition of the Sky’s Colors**

(The circle shows the actual size of the brush)

![Hardness = 80%](image1)

![Hardness = 40%](image2)

- **Strength** (1-100). Amount of Lighten applied to an image. When **Strength** = 100% the maximum amount of lightening is applied to an image.

![Strength = 20%](image3)

![Strength = 95%](image4)

The drop-down menu **Range** contains three ways to process pixels:

- **Shadows**. Darker areas are processed more than lighter areas.
- **Midtones**. The brush affects both light and dark areas equally.
- **Highlights**. Lighter areas of the image are processed more than darker areas.

**Lighten Applied to an Image in Different Ranges**

![Lighten Applied to an Image in Different Ranges](image5)
To lighten an area in a straight line, first select the starting point by clicking the left mouse button, then, while keeping **Shift** pressed, bring the cursor to the desired end point and release **Shift**. If **Shift** is not released, additional lines will be drawn to each point where the mouse is clicked.
The **Darken** tool tones an image by decreasing the brightness of colors. The effect is increased with each successive brush stroke. To quickly access this tool and switch between the **Lighten**, **Darken**, and **Saturation** tools press **L**.

The tool's parameters will be shown in a floating box over an image (by right-clicking the mouse) and also in the **Settings Panel**.

To change a parameter, enter a numerical value in the parameter's field and press **Enter** (Macintosh: **Return**) or adjust the slider.

- **Size** (1-1000). Size of the **Darken** brush.
- **Hardness** (0-100). The degree of softness of the tool's edge. The higher the value, the sharper the tool's edges are. At values near 100%, the boundary between the darkened area and untreated area is more distinct; at lower values there is a smoother transition between these areas.

"Ripening" Cranberries

Hardness = 40%  
Hardness = 95%

Strength = 30%  
Strength = 95%

- **Strength** (1-100). The amount the image is darkened. At a **Strength** value near 100% the colors are darkened near maximum.

The drop-down menu **Range** provides three methods for darkening an image.

- **Shadows**. Dark areas are processed more strongly than light areas.
- **Midtones**. Dark and light areas are processed equally.
- **Highlights**. Light areas are processed more strongly than dark areas.

**Darkening an Image in Different Ranges:**
To darken colors in a straight line, first select a starting point for the line by left-clicking over the desire point, then, while pressing \texttt{Shift}, move the cursor to the desired end point and release \texttt{Shift}. If \texttt{Shift} is not released, then new lines will be drawn to each point where the mouse is clicked.
The **Saturation** tool [ Đường dẫn đến hình ảnh ] tones an image by changing the saturation and contrast of neighboring pixels. The tool works in two modes: in **Saturate** mode colors become more saturated, in **Desaturate** mode colors become less saturated. To quickly access this tool and switch between the **Lighten**, **Darken**, and **Saturation** tools press **L**.

The tool's parameters will be shown in a floating box over an image (by right-clicking the mouse) and also in the **Settings Panel**.

To change a parameter, enter a numerical value in the parameter's field and press **Enter** (Macintosh: **Return**) or adjust the slider.

- **Size** (1-1000). Size of the **Saturation** tool.
- **Hardness** (0-100). The softness of the tool's edge, where the effect is applied partially. At higher values the boundary between treated and untreated areas is more distinct; at lower values the transition between these areas is processed more smoothly.

**Influence of a Hard Brush Edge on a Rainbow**

- **Strenght** (1-100). The strength of the effect. The higher the value, the stronger the change.

**Changing the Colors**
To change saturation in a straight line, pick a starting point by left-clicking the mouse, then, while pressing \textit{Shift}, move the cursor to the desired end point and release \textit{Shift}. If \textit{Shift} is not released, then a new line will be drawn to each point where the mouse is clicked.
The **Oil Brush** was designed to imitate painting with an oil brush and paints strokes with a relief. The density of the stroke varies across the entire line. Press B to quickly access this tool.

The tool's parameters will be shown in a floating box over an image (by right-clicking the mouse) and also in the **Settings Panel**.

To change a parameter, enter a numerical value in the box for that parameter and press **Enter** (Macintosh: **Return**) or move the slider.

- **Size** (3-150). The maximum line width which can be obtained by the brush (in pixels).
- **Relief** (0-100). The prominence of stroke details. As this parameter is increased, the pattern left by the brush's hairs in the paint is more pronounced and the relief of strokes is stronger.

![Relief examples]

- **Paint Reserve** (0-100). The length of painted lines. When the paint runs out, the brush stops painting on the surface and leaves a raised, faded stroke of paint.

![Paint Reserve examples]

- **Color Mixing** check box. This defines the state of the paint in when applied by the brush. When this check box is activated, paint strokes will mix together as if the paint is wet. If the check box is deactivated, the paint will behave as if it is drying, and brush strokes will not mix together.
Paint color is set through the **Color/Swatches** palettes. To choose a different color bring the cursor over the spectral bar (the cursor will take the shape of a pipette) and click on the desired color or double-click on the square and choose a color from the **Select Color** dialog. In some cases, selecting a color is more convenient than manually selecting the components of a color via the sliders.
The **Roller** simulates rolling paint on an image. The brush leaves flat, porous strokes. The paint's density varies along the line's length. Press **R** to quickly access this tool.

The tool's parameters will be shown in a floating box over an image (by right-clicking the mouse) and also in the **Settings Panel**.

To change the setting for a parameter, enter a numerical value in its box and press **Enter** (Macintosh: **Return**) or move the slider.

- **Size** (10-200). The maximum width of a line made by the brush (in pixels).
- **Fill** (0-100). The paint's density in a single brush stroke. When strokes are painted over one another, the paint becomes denser. At lower values of this parameter, the color of applied strokes is weaker. When the parameter is set to 100%, the brush draws strokes in the full density of the chosen color.

![Example of Fill settings](image1.png)

- **Paint Reserve** (0-100). Affects the brush strokes length. When the paint runs out, the brush stops painting on the surface and leaves behind a raised transparent trace of paint.

![Example of Paint Reserve settings](image2.png)

- **Color Mixing** check box. This defines the state of the paint in when applied by the brush. When this check box is activated, paint strokes will mix together as if the paint is wet. If the check box is deactivated, the paint will behave as if it is drying, and brush strokes will not mix together.
Paint color is set in the **Color/Swatches** palettes. To choose a different color bring the cursor over the spectral bar (the cursor will take the shape of a pipette) and click on the desired color or double-click on the square and choose a color from the **Select Color** dialog. In some cases, selecting a color is more convenient than manually selecting the components of a color via the sliders.
The **Felt-tip Marker** is a special tool with constantly flowing paint. It draws smooth, elegant, translucent lines. Press **F** to quickly access this tool.

The tool’s parameters will be shown in a floating box over an image (by right-clicking the mouse) and also in the **Settings Panel**.

To change the setting of a parameter, enter a numerical value in that parameter's box and press **Enter** (Macintosh: **Return**) or move the slider.

- **Size** (3-100). The maximum width of a line which the tool will draw (in pixels).
- **Fill** (0-100). The ink's density in a single brush stroke. When strokes are drawn over one another, the ink becomes denser. At lower values of this parameter, the color of applied strokes is weaker. When the parameter is set to 100%, the tool draws strokes in the full density of the chosen color.

Paint color is set in the **Color/Swatches** palettes. To choose a different color bring the cursor over the spectral bar (the cursor will take the shape of a pipette) and click on the desired color or double-click on the square and choose a color from the **Select Color** dialog. In some cases, selecting a color is more convenient than manually selecting the components of a color via the sliders.
CHALK

Chalk ✍️ draws soft, textured lines with porous edges. Press C to quickly access this tool.

The tool's parameters will be shown in a floating box over an image (by right-clicking the mouse) and also in the Settings Panel.

To change a parameter's setting, enter a numerical value in that parameter's box and press Enter (Macintosh: Return) or move the slider.

- **Size** (3-200). The maximum width of a line drawn by the tool (in pixels).
- **Strength** (0-100). The strength of the tool's influence on an image. At higher values, the line drawn by the chalk will be thicker and its edges will be sharper.

![Image of Chalk with different strengths](image)

The chalk's color is set in the Color/Swatches palettes. To choose a different color bring the cursor over the spectral bar (the cursor will take the shape of a pipette) and click on the desired color or double-click on the square and choose a color from the Select Color dialog. In some cases, selecting a color is more convenient than manually selecting the components of a color via the sliders.
**ARTISTIC PENCIL**

The **Artistic Pencil** draws lines with sharp boundaries and applies paint smoothly (without relief). Press P to quickly access this tool.

The tool’s parameters will be shown in a floating box over an image (by right-clicking the mouse) and also in the **Settings Panel**.  
To change the setting for a parameter, enter a numerical value in its box and press Enter (Macintosh: Return) or move the slider.

- **Size** (3-50). The maximum width of a line drawn by the tool (in pixels).
- **Fill** (0-100). The lead’s density in a single pencil stroke. When strokes are drawn over one another, they becomes denser. At lower values of this parameter, the color of applied strokes is weaker. When the parameter is set to 100%, the pencil draws strokes in the full density of the chosen color.

![Fill = 10](image1) ![Fill = 80](image2)

- **Tilt** (0-100). Imitates a pencil’s tilt: pressure on one edge of the line is weakened. The stronger the pencil's tilt, the greater the difference between edges.

![Tilt = 30](image3) ![Tilt = 80](image4)

- **Grain** (0-100). It adds noise to the pencil strokes, makes the lines less dense. The effect is visible at the low values of the **Fill** parameter.
The pencil’s color is set in the **Color/Swatches** palettes. To choose a different color bring the cursor over the spectral bar (the cursor will take the shape of a pipette) and click on the desired color or double-click on the square and choose a color from the **Select Color** dialog. In some cases, selecting a color is more convenient than manually selecting the components of a color via the sliders.
Artistic Spray simulates spray painting on an image. The brush does not apply paint in a continuous line, but rather in raised drops, scattered along the stroke. Press A to quickly access this brush.

The tool’s parameters will be shown in a floating box over an image (by right-clicking the mouse) and also in the Settings Panel.

To change a parameter’s setting, enter a numerical value in its box and press Enter (Macintosh: Return) or move the slider.

- **Size** (1-300). The maximum width of a line applied by the brush (in pixels).
- **Drop Density** (1-100). The density of drops in the total area of a stroke. At higher value more drops are applied in a stroke.

**Poppy Seed Bagel**

![Poppy Seed Bagel](image)

- Drop Density = 10
- Drop Density = 55

- **Drop Size** (1-50). The diameter of individual dots. Larger dots will merge, forming strangely shaped line with irregular edges.

**Air Bubbles in an Aquarium**

![Air Bubbles in an Aquarium](image)

- Drop Size = 6
- Drop Size = 20

Paint color is set in the Color/Swatches palettes. To choose a different color bring the cursor over the spectral bar (the cursor will take the shape of a pipette) and click on the desired color or double-click on the square and choose a color from the Select Color dialog. In some cases, selecting a color is more convenient than manually selecting the components of a color via the sliders.
The Artistic Eraser erases an image on the selected artistic layer. This tool changes the transparency of pixels and removes the relief of paint. Press E to quickly access this tool.

The tool's parameters will be shown in a floating box over an image (by right-clicking the mouse) and also in the Settings Panel.

To change the setting of a parameter, enter a numerical value in its box and press enter (Macintosh: Return) or move the slider.

- **Size** (1-300). The maximum width of a line the tool erases (in pixels).
- **Strength** (0-100). The impact of the tool on an image. The higher the value, the greater the change in transparency of pixels. At low values only the relief of an image is erased.

**Trimming Edges With the Eraser**

![Strength = 20](image1.png) ![Strength = 100](image2.png)
ALIGNMENT TOOLS

Use the alignment tools to move and precisely position objects (layers). **Rulers** are shown along the edges of the Image Window. **Guidelines** (as well as the **Grid**) are nonprinting supporting horizontal and vertical lines which are displayed over the image (they will not appear on the final result).

To create a horizontal/vertical guideline, place a cursor over a corresponding ruler, and holding the left mouse button, drag a blue line which appears under the cursor. You can move the guidelines with the **Move** tool (the cursor will turn into ![Move Tool](image))

Guidelines

To remove the guideline, drag it outside of the Image Window.

Click on the button in the top panel to open the alignment tools menu:

- **Show Rulers**
- **Show Grid**
- **Enable Guidelines**
- **Lock Guidelines**
- **Clear Guidelines**

Snap To Options...

- **Grid**
- **Guidelines**
- **Selection**
- **Layers**
- **Document**

**Show Rulers.** When this option is enabled, you can see the rulers along the edges of the Image Window. Right mouse clicking on a ruler lets you select the units of measurement (pixels, inches, centimeters, etc.).

Marks on the rulers indicate the position of the cursor.

To change the origin (zero), place the cursor over the intersection of the rulers in the upper left corner of the Image Window and drag diagonally to the desired point in the image. To restore
the default origin, double-click this corner.

- **Show Grid.** When this option is checked, the grid appears over the image. The grid's point of origin depends on the rulers origin.

- **Enable Guidelines.** When this option is checked, the guidelines are shown. When the option is deactivated, the guidelines are not displayed, cannot be created and cannot be used for snapping.

- **Lock Guidelines.** This option prevents repositioning the guidelines.

- **Clear Guidelines.** This command deletes all guidelines.

- **Snap To.** This feature helps to precisely position the object which "clings", when moving, to the edge of a selected element. You can specify elements to which to snap (they must be visible):
  - Grid;
  - Guidelines;
  - Selection;
  - Layers;
  - Document.

- **Options.** This command opens the dialog box where you can adjust the display options for the alignment tools.

There are three groups of the preferences:

- **Rulers:**
  - **Color** for each element of the rulers can be changed by clicking on the corresponding color square:
    - Background.
    - Divisions.
    - Cursor Marker.
  - **Units** of measurement can be changed here, in the drop-down list, or with a right mouse click on a ruler.

- **Guidelines:**
  - **Color** of the guidelines can be selected by clicking on the color square.
  - **Style** defines a display option for the guidelines (Lines, Dashed Lines, Dots).

- **Grid:**
  - The grid consists of the main lines and the additional lines (subdivisions).
  - **Color** of the grid lines can be changed by clicking on the color square.
  - **Step** adjusts the grid spacing between the major lines. You can change units for this option.
**Subdivisions** - this option defines the spacing for the minor lines.

You can adjust a view mode for the grid lines (**Lines, Dashed Lines, Dots**). There are two drop-down lists for each type of the lines: **Style 1** is used for the main lines, **Style 2** - for the subdivision lines.
SELECTION TOOLS

Selection tools let you specify an editing area on an image. The selected area is marked by a dotted outline. The retouching and artistic tools work only in the selection. You can move the selection outline in the image - place the cursor inside the selected area and drag.

Press \( V \) to quickly access the selection tools and switch between them.

![Selection](image)

Selections Tools:

- **Rectangular Selection** lets selecting rectangular and square areas. Drag over the area you want to select with the left mouse button.
- **Elliptical Selection** lets selecting elliptical or circular areas.
- **Lasso** allows creating freehand selections. Drag to draw a selection line around an object. When you release the left mouse button, the contour will be closed, the final point will be connected to the start one.
- **Polygonal Lasso** lets creating a freehand selection from straight segments. Move the cursor and left-click on each point, the program will automatically draw a straight line between two points. To close the contour bring the cursor to the first point or make a double-click in the final point.

Commands:

- **Deselect** \( Ctrl+D \) (Windows) or \( ⌘+D \) (Macintosh).
- **Select All** \( Ctrl+A \) (Windows) or \( ⌘+A \) (Macintosh).
- **Inverse Selection** \( Ctrl+Shift+I \) (Windows) or \( ⌘+⇧+I \) (Macintosh).

Hold \( Shift \) to make a square or a circle and to draw a perfectly vertical/horizontal line.

The tools options will be shown in the Settings Panel and in a floating box when right-clicking on the image:

- **Selection Mode** defines the result of the interaction of selections:
- **New**. When creating a new selection, the previous selection disappears.
- **Add**. The selection area will be increased by adding new fragments.
- **Subtract**. This mode lets removing the part of the selection.
- **Intersect**. This mode lets keeping only the intersection area of the selections.

- **Feather** lets blurring edges of the selection.

- **Anti-aliasing** check-box smooths the jagged edges of the selection. Enable this option before creating a selection.

- **From Center** check-box lets creating a selection (a rectangle or an ellipse) using a start point, where the cursor is, as a center. Otherwise, selections are created from a corner.
Style. You can specify a size of a selection:
- Normal. The size of a selection is determined by dragging the cursor.
- Fixed Size. This option lets you create a selection with exact dimensions (height and width, in pixels).
- Fixed Ratio. The ratio of height and width of a selection remains fixed.
The **Crop** tool allows cutting off an image. It helps to remove unwanted areas, to improve focus, or to make a square from a rectangular or contrariwise. To quickly access the tool use `Alt+C`.

Select an area you want to keep - drag while holding left mouse button. A rectangular frame will appear over the image, and the tool's options will be displayed in the Settings Panel. All parts outside of the frame will be cut out.

You can change the size of the area by dragging the markers on the sides and angles of the bounding frame. To constrain the proportions hold down `Shift`.

To move the frame, place the cursor inside it and drag.

To rotate the area, place the cursor outside the frame, and move it with the left mouse button. If you press `Alt`, the rotation angle will change in 5 degrees.

Blue markers on the bounding frame indicate where will be the top of the cropped image. If the frame is beyond the image, the empty area will be filled with a transparent background.

To apply the tool and remove the areas outside the frame, click on **OK** or press `Enter`. To cancel the selection, press **Cancel** or use the `Esc` key.

**Tool's Options:**

- The tool can work in two modes:
  - **Delete.** The areas outside of the bounding frame will be deleted.
  - **Hide.** The areas outside of the frame will be hidden but still accessible. This mode lets you correct the cropped area later - you can move the visible part with the **Move tool**.
- **External Area.** The check-box helps to better visualize areas in and outside of the crop frame. If the check-box is enabled, the outer parts are highlighted in a selected color.

Adjust the visualization options for the external area:
- **Color.** Click on the color square to open the Select Color dialog box.
  - **Opacity.** The parameter defines the transparency of the highlight color.
The **Move** tool lets you drag an object (layer) holding the left mouse button. The hot-key for the tool is **M**.

### Tool's Options:

- **Auto Select** check-box lets automatically selecting a layer or a group when you click on the object. Use this feature when working with a multilayer document. You do not need to manually select the layer in the **Layers** palette.

- **Show Bounds** check-box. This option lets you show/hide the edges of the moving object.
Using the Move tool, it's also possible to transform an object.

*Show Bounds* option is activated

*Show Bounds* option is deactivated
TRANSFORMING OBJECTS

Using the **Move** tool, it's possible to transform a layer or a selected area. The transformation parameters appear in the Settings Panel when clicking on a bounding frame.

Transformation Options:

- **Move.** You can change the position of the object horizontally (X) and vertically (Y). The parameter uses the coordinates (in pixels) of the upper left point of the bounding box or of the center point (if the sign is activated). Usually the center point is fixed, but you can move it to the different location.

  Place the cursor inside the bounding frame and drag the object. If you bring the cursor to the center point, you will get a pointer with a circle - now you can move only the center point.

- **Scale.** You can adjust the size of the object in width (W) and height (H) (in per cent). Drag one of the eight square markers on the frame to increase or reduce the size. The cursor will turn into a two-sided arrow.

  Use **Shift**-key or press the sign between W and H to constrain the proportions of the object. If the sign is deactivated, the proportions can change.

- **Rotate.** You can rotate the object. The center of rotation can be changed by moving the center point of the object. Outside the bounding frame the cursor turns to a rounded two-sided arrow. Holding down the left mouse button, rotate the object clockwise or counterclockwise. If you press **Alt**, the rotation angle will change in five degrees.

  You can specify a degree of rotation in the Settings Panel into the A (angle) field.

- **Skew.** You can shift some parts of the object relative to the others. When you bring the cursor to the frame, it will look like this. Press and drag to transform the object.

  You can also enter the values in the Settings Panel into the fields H (horizontal skew) and V (vertical skew).
Click on the **Reset Center Point** button to restore the center point in its default position. Press **OK** to apply changes. To cancel the transformation press **Cancel** or use the **Esc**-key.
The **Text tool** lets adding text to an image. The hot-key for the tool is T.

When you entering text, it appears on a special text layer. You can convert this layer to a regular one with the **Rasterize Layer** command. After text rasterization you will not be able to change or reformat it.

There are two ways to add text: as a text block (in the bounding box) or as a line (free typing).

Drag the cursor while holding left mouse button - the bounding box will appear where you can enter text. You can change the size of the box by dragging the markers on the frame. Hold down **Shift** to constrain the proportions. To move the block, place the cursor outside and drag.

Alternatively, you can add text by clicking with the tool on an image, just start typing. In this case, text lines are not limited in length.

Regardless of the mode, you can start a new line with **Enter** key.

To apply text press **OK** in the Settings Panel or select another tool in the Toolbar. To cancel click on
Cancel or use Esc.

Formatting options will appear in the Settings Panel. You can apply them to selected characters or to entire text.

- **Font Family.** The drop-down list contains a set of system fonts that can be used when typing text.
- **Font Size.** The parameter sets the size of the characters (in points).
- **Character Styles:**
  - Bold
  - Italic
  - ALL UPPERCASE
  - all lowercase
  - Capitalize (All Initial Caps)
  - Subscript
  - Superscript
  - Underline
  - Strikethrough
- **Anti-aliasing.** Click \( \text{AA} \) to apply anti-aliasing rendering for text.
- **Font Color.** The current color is shown on the color plate. To change the color, click on the plate and select a new color from the Select Color dialog box.
- **Alignment Options:**
  - Align Left
  - Align Center
  - Align Right
  - Justify
- **Margin Options.** You can adjust space between text and the bounding box (in pixels):
  - Left Margin
  - Right Margin
  - Indent First Line

Right-clicking on text opens a menu of standard commands.
- **Undo.** The command lets you undo a last change.
- **Redo.** The command lets you reapply a previously undone change.
- **Cut.** The command removes the selected fragment while taking it to a clipboard.
- **Copy.** The command duplicates the selected fragment to the clipboard.
- **Paste.** The command lets inserting data from the clipboard.
- **Delete.** The command removes the selected fragment without saving it to the clipboard.
- **Select All.** The command selects entire text on this layer.
- **Convert to Text Block/Convert to Free Text.** The command changes the type of text.

You can transform the text block with the pressed Ctrl-key. It is important to distinguish this mode from simple changing of the bounding box.

It's also possible to transform text using the Move tool.
The Eyedropper tool lets selecting a color from an image. Press to quickly access this tool.

A color selected with a mouse-click is shown as the current color in the Color palette. If you move a cursor holding down the Eyedropper tool you can see how the current color dynamically changes. Moving the Eyedropper with the pressed key averages out colors along all pixels in the cursor’s path.

Adjust the tool’s options in a popup menu which shows when right-clicking on the image or in the Settings Panel.

Eyedropper Options

- **Sample Size** (1-51). The number of pixels around the eyedropper's tip that are used to average the selected color. At minimum values, the area around the eyedropper's tip is reduced to one pixel. A higher value of the parameter can be used on photos with a lot of color noise (random red and blue pixels on homogeneous background).

  In the popup menu you can select between the variants. In the Settings Panel it's possible to set more precise Sample Size using the slider or entering a numerical value in the parameter field.

- **Show Color Ring** check-box. If the option is enabled, the eyedropper's cursor is displayed as a Color Ring with 5 sectors that lets to get more information about the colors in this area.

  1. Gradient line with the current color in the center, on the left side is +30% black, and on the right side +30% white.
  2. The previously selected color.
  3. The current color of the pixel where the cursor is.
  5. Average colors from areas of 3x3, 5x5, 11x11, 31x31, 51x51, 101x101 px (around the eyedropper's tip).

  This feature helps you select colors more precisely. If it’s hard to catch a certain color, you can
see adjacent tints in the **Color Ring** and select the color on the ring while holding the **Ctrl** key.
The **Hand** tool is designed to scroll the displayed area of the image in the window if the whole image doesn't fit into the window at the chosen scale. To move the image you should press this button, put the cursor onto the image, press the left button and, keeping it pressed, move the image in the window. Press \texttt{Alt}+\texttt{H} to quickly access this tool.

[![Scrolling of displayed area](image.png)](image.png)

Double-clicking on the tool's icon on the **Toolbar** makes the image fit the **Image Window** (Fit to View).

Even if another tool is active, you can press the spacebar on the keyboard and drag the image with the left mouse button to scroll the image in the **Image Window**.
**ZOOM**

The **Zoom** tool is designed to change the image scale. Press `Z` to quickly access this tool. To zoom in left click on the image. To zoom out left click with `Alt` on the image.

It is also possible to increase the scale of the selected area. For this purpose press `Q` and select a rectangular area. When the rectangular area is selected, the image scale will be changed so that the selected part of the image will fill the whole window.

![Increase the scale of the selected area](image)

Double-clicking on the tool's icon `Q` on the **Toolbar** makes the image scale to 100% (Actual Size).

Even if another tool is active, you can use these hotkeys:

- to zoom in: `+` and `Ctrl`+`+` on Windows, `⌘`+`+` on Macintosh,
- to zoom out: `-` and `Ctrl`+`-` on Windows, `⌘`+`-` on Macintosh.
AKVIS MultiBrush is not only a drawing tool, but a magical stylist, which can change your appearance with two strokes of a brush. In this tutorial we will share a secret of how to make a photograph "stand out", to make the subject in a portrait even more pleasing to the eye.

Each of us are born with a unique eye color. But girls like to experiment with different looks! It's not so difficult.

**Step 1.** Open a photo in **AKVIS MultiBrush**.

**Step 2.** Create a new layer above the image (with the button).
Step 3. Choose the **Color Brush** tool and paint the desired color over the iris.

**Painting New Color**

Step 4. Under the settings for the **Layers** Palette, change the **Opacity** parameter for the top layer to between 20 and 30%.

**Changing Opacity**

Feel free to experiment, you can change eye color without buying expensive lenses:
Even something like this:
AKVIS MultiBrush helps you to retouch photos and enhance portraits. It removes unwanted objects from digital pictures.

We will try to see how this girl looks without the eye glasses.

- **Step 1.** Open the photo in your photo editor and select the **AKVIS MultiBrush** plug-in.
  
  You can also open the photo in the **standalone** version of **MultiBrush** and achieve the same results.

- **Step 2.** Select the **Chameleon Brush** and adjust its size.

- **Step 3.** Deactivate the check box **Aligned** so that every time you apply the brush the pattern is taken from one and the same starting point.

- **Step 4.** Press the **Alt**-key (**Option** in Macintosh) and use the left mouse button to sample the girl's forehead, it will be the source area.
Step 5. Apply the brush to the frame of the eye glasses with strokes.

Step 6. Press the button in the Control Panel to apply the result of the retouching and close the plugin window.
You can also use this method to remove small defects, such as freckles, scars, birthmarks, wrinkles, you can even remove piercing or tattoo.
Click on the image to see a larger version in a new window.
ODD MAN OUT

We are going to remove the odd parrot who indiscreetly stares at the kissing sweethearts. It’s quite easy as the background is blurred and does not have prominent details. The only thing that requires some effort is the removal of the branch the parrot is sitting on.

Step 1. Open the photo in your photo editor. You can also open the photo in the standalone version of MultiBrush and achieve the same results as in this example.

Step 2. Call the AKVIS MultiBrush plugin. For this purpose, in Adobe Photoshop select the menu item Filter -> AKVIS -> MultiBrush, in Corel (Jasc) Paint Shop Pro - the menu item Effects -> Plugins -> AKVIS -> MultiBrush; in Corel Photo-Paint select the command Effects -> AKVIS -> MultiBrush.

Step 3. We will remove the odd parrot using the Artistic Cloning of the Chameleon Brush.

In this mode you can change the size of the brush, indicate another source for cloning and make a clone out of different parts of the image. The program will not fuse the cloned area with the background until you quit the mode.

Step 4. We start removing the parrot by replacing it with appropriate image fragments. First we clone the branch.

We set the source for cloning by pressing the Alt key (Option on Macintosh) and clicking with the left mouse button on the branch on the right of the parrot.
Step 5. Draw the first line and the branch will be copied to the place where the parrot used to sit.

We set the second source for cloning a bit lower than the first one and we continue cloning the branch until it is completely restored.

Step 6. Now we remove the tail of the parrot. We set the cloning source lower than the branch and clone it in place of the parrot.
If you've made a mistake when cloning a fragment, you can use the button to cancel the last operation.

- **Step 7.** Now we clone the upper part of the parrot's body. We clone the fragment on the right of the parrot above the branch.

- **Step 8.** Retouch minor imperfections on the branch using the stamp. The parrot is removed, the branch is restored, but the borders of the cloned area are still visible. Now we start the processing by pressing the button.

The program will process the borders of the cloned area in such a way that the clone fuses with the background. The odd parrot has disappeared without leaving a trace.
ALTER EGO

The author of this example is **Gun Legler**. She used the plugin version of **AKVIS MultiBrush** with **Paint Shop Pro**.

With the **standalone** version of **MultiBrush** you can achieve the same results as in this example.

Gun Legler applied the **AKVIS MultiBrush** plugin to add a cloned image of the girl to the original picture. When a clone of the specified object is adjusted to the background, the resulting picture has a different color range and lightness.

To achieve the same result follow the instructions:

1. **Step 1.** Open the original image in your photo editor and call **AKVIS MultiBrush** by calling the command:
   - in Paint Shop Pro: **Effects -> Plugins -> AKVIS -> MultiBrush**;
   - in Photoshop: **Filter -> AKVIS -> MultiBrush**.

2. **Step 2.** Select the **Chameleon Brush** tool from the **Toolbar** and adjust the size of the brush.

3. **Step 3.** Activate the check-box **Aligned**, so that every time you apply the stamp the patterns are taken in sequence concerning the source point. Therefore, you do not need to clone the girl in one stroke.

4. **Step 4.** Keeping the **Alt**-key pressed, specify the starting point for cloning on the face of the girl.

5. **Step 5.** Move the cursor to the right upper corner and clone the girl’s face.

6. **Step 6.** Press the button on the **Control Panel** to apply the result.
AKVIS PROGRAMS

AKVIS AirBrush — Airbrushing Techniques on Your Photos
(Windows | Mac OS X)
AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special airbrush tool that sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush designs from images using chosen settings of photo-to-painting conversion. More...

AKVIS ArtSuite — Apply Effects to Your Photos!
(Windows | Mac OS X)
AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many templates and texture samples that can be used to create a virtually limitless variety of options for generating frames.
Decorate a photo to give it an original and festive look! More...
**AKVIS ArtWork — Convert Your Photo Into Painting**

(Windows | Mac OS X)

AKVIS ArtWork is photo to painting software, it is designed to imitate different painting techniques (Oil, Watercolor, Gouache, Comics, Pen&Ink, Linocut, Pastel). ArtWork helps you to create a piece of art out of any digital photo.

Create an oil portrait of your friend, a landscape painting or a still life picture. Express yourself in new genres! More...
**AKVIS Chameleon — Photo Collage Creation**  
(Windows | Mac OS X)  
AKVIS Chameleon is a fun to use tool for photo collage creation. It makes the process easy and entertaining. The tool is very easy to handle as it does not require precise selection of objects.  
Create your own photo collages! More...

**AKVIS Coloriage — Add Color to Black and White Photos**  
(Windows | Mac OS X)  
AKVIS Coloriage allows colorizing B&W photos and replacing colors in color photos. Just indicate the desired colors by the stroke of the brush; the program does the rest of the work: recognizes the object's border and tailors the new color to the grayscale tones of the initial picture. More...

**AKVIS Decorator — Resurface and Recolor**  
(Windows | Mac OS X)  
AKVIS Decorator lets you change the surface of an object in a realistic manner. The program puts on a texture keeping the volume of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things differently. Recoloring is also made easy. More...
AKVIS Draw — Hand-made Pencil Drawing Effect
(Windows | Mac OS X)
AKVIS Draw converts your photo into a hand made pencil drawing. The software creates realistic looking line art illustrations, produces both B&W and color drawings. Add a hand-drawn look to your pictures! More...

AKVIS Enhancer — Photo Enhancement Software
(Windows | Mac OS X)
AKVIS Enhancer is image enhancement software that detects detail in underexposed, overexposed and mid tone areas of a photo with uneven exposure. Enhancer improves every part of the image! The software works in three modes: Improve Detail, Prepress, and Tone Correction. The program offers a fast method to fix a dark photo, add contrast and brightness to a picture, it lets you improve color and adjust tones. More...

AKVIS HDRFactory — Brighter than Reality!
(Windows | Mac OS X)
AKVIS HDRFactory lets you create an HDR image from a series of shots or from one single photo. The program can also be used for photo correction.

AKVIS HDRFactory brings life and color to your photos! More...

AKVIS LightShop — Light and Star Effects
(Windows | Mac OS X)

AKVIS LightShop lets you create an infinite number of astounding light effects! The program offers advanced lighting techniques for adding stars and glow effects to images. A light effect draws attention and brighten up any photo. Add a little magic to your pictures! More...

AKVIS Magnifier — Change Image Size without Quality Loss
(Windows | Mac OS X)

AKVIS Magnifier helps to resize images without loss in quality. Whether creating poster-size images, adding resolution for printing an enlargement, or reducing image size, Magnifier will make your prints look sharper and better defined. More...
AKVIS MakeUp — Create Your Ideal Portrait!
(Windows | Mac OS X)
AKVIS MakeUp improves portraits and adds glamour to photos, giving them a professional look. The software lets you retouching small defects on a skin, making it radiant, beautiful, pure and even, as you can see on artistic images. More...

AKVIS MultiBrush — Photo Retouching Made Easy
(Windows | Mac OS X)
AKVIS MultiBrush makes it easy to retouch photos and enhance portraits. Featuring a collection of healing and enhancement brushes, stamping and drawing tools, AKVIS MultiBrush helps artists, photographers and home users to perform portrait enhancement, retouch image flaws and remove unwanted objects from digital pictures, paint funny details on a photo or create an image from scratch. The program offers two sets of tools — Standard and Artistic Brushes. More...
AKVIS NatureArt — Bring Nature To Your Photos

(Windows | Mac OS X)

AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your digital photos. Nature effects have an impact on our mood and can be used to strengthen the impression from a picture.

Add dramatic nature effects to your photo, change the weather on it! With NatureArt you can become a wizard! More...

AKVIS Noise Buster — Noise Reduction Software

(Windows | Mac OS X)

AKVIS Noise Buster is software for noise suppression on digital and scanned images.
Digital noise can be seen as artifacts and random red and blue pixels that compromise the smoothness of a photo. The program is efficient against both color and luminance noise. More...

AKVIS OilPaint — Oil Painting Effect
(Windows | Mac OS X)
AKVIS OilPaint turns your photos into oil paintings. The mysterious production of a painting happens right before your eyes. The unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge software you can become a painter! More...

AKVIS Refocus — Focus Improvement & Blur Effects
(Windows | Mac OS X)
AKVIS Refocus improves sharpness of out of focus images. The program can process the entire photo or bring into focus only the selected part to make the subject stand out against the background. It’s also possible to add bokeh and lens blur effects to your photos.
The software works in three modes: Refocus, Tilt-Shift, and Iris Blur. More...
AKVIS Retoucher — Image Restoration Software
(Windows | Mac OS X)
AKVIS Retoucher is an efficient program for photo restoration and photo retouching.
The software removes dust, scratches, stains, and other defects that appear on damaged photos. It intelligently reconstructs the missing parts of the photo using the information of the surrounding areas.
More...

AKVIS Sketch — Convert a Photo to a Pencil Sketch
(Windows | Mac OS X)
AKVIS Sketch converts digital photos to amazing pencil sketches and watercolor drawings.
Now you do not need to handle a pencil to feel like an artist. All you need to create your original work of art is good taste and AKVIS Sketch. More...
AKVIS SmartMask — Save Time on Complex Selections!

(Windows | Mac OS X)

AKVIS SmartMask is an efficient selection tool that saves time and is fun to use. Selection has never been so simple!

With AKVIS SmartMask you can considerably increase your productivity! You will be freed from boring work and will have more room for creativity and realization of your ideas. More...

AKVIS MultiBrush